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Unpacking, Positioning and I nstallation

e Ingpect the instrument for any signs of damage caused in transit. If any damageis
discovered, inform your supplier immediately. Check the position of the metal lamp
bracket inside the lamp access area.

e  Ensureyour proposed installation site conforms to the environmental conditions for safe
operation:

Indoor use only

Temperature 5°C to 35°C. Note that if you use the instrument in aroom subject to
extremes of temperature change during the day, it may be necessary to recalibrate (by
switching off and then on again) once thermal equilibrium has been established (2-3
hours).

Maximum relative humidity of 80 % up to 31°C decreasing linearly to 50 % at 40°C

e  Theinstrument must be placed on a hard, flat bench or table that can take its weight (<2
kg) such that air is allowed to circulate freely around the instrument.

e  Thisequipment must be connected to the power supply with the power cord supplied. It
can be used on 90 - 240V supplies.

®  Switch on theinstrument viathe display after it has been plugged in. The instrument
performs a series of self-diagnostic checks for |lamp performance, wavelength calibration
and diode array pixels; press F2 to proceed.

If the instrument has just been unpacked or has been stored in a cold environment, it should
be allowed to come to thermal equilibrium for 2-3 hoursin the laboratory before switching on
to prevent calibration failure as aresult of internal condensation.

®*  Thecell holder supplied with the instrument accepts standard 10mm pathlength glass or
plastic cells (adapters are available to convert it to accept 10, 12 and 16mm diameter test
tubes). It can be removed for cleaning if spillages occur by undoing the screws that hold
it or it can be flushed through with water in situ.

® |f theinstrument has a heated cell holder option and it ison, allow 10 minutesfor it to
come to thermal equilibrium. This cell holder cannot be removed.

If this equipment is used in amanner not specified or in environmental conditions not
appropriate for safe operation, the protection provided by the equipment may be impaired and
instrument warranty withdrawn.

Essential Safety Notes

There are anumber of warning labels and symbols on your instrument. These are
there to inform you where potential danger exists or particular caution is required.
Before commencing installation, please take time to familiarise yourself with these
symbols and their meaning.

Caution (refer to accompanying documents).
Background colour yellow, symbol and outline black.
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OPERATION
| ntroduction

Y our spectrophotometer is a simple-to-use, microprocessor controlled instrument. Itisa
diode array product (1024 pixels), has no moving parts and scans very quickly.

After switch on, calibration and pressing F2 to proceed the home page is shown offering the
choice of

o Repeat last operation
° Make a measurement
o Set up instrument

“Repeat last operation” returns the user to the last screen displayed when the instrument was
switched off, and provides a short cut to the last test that was performed.

Within “Make a measurement” your spectrophotometer has facilities for:

o measurement of absorbance, % transmission, ratio and concentration values
¢ cell culture optical density measurements at 600nm

o entry of amulti point standard curve in memory

° output of wavelength scan to display

o output of kinetics assay to display

o application of afactor to an absorbance change over a specified time interval for an
enzymatic determination (reaction rate)

o storage of up to 99 user defined methods

Within “ Set up instrument” your spectrophotometer can be set up to
o select the display language option (English, French, German, Spanish, Italian)

o link viaa serial lead to either aseria printer for hardcopy output or to a PC for
download of results to spreadsheet
o link viaa converter lead to chart recorder

¢ set the date for print outs

The instrument is supplied with Grafico PC utility - on the accompanying CD - and a seria
lead. These provide the user with the means to capture, print and store data from the
instrument to a PC. Specifically it

e produces a printable graphical plot of the scan, in Abs

e logsdate, time and serial number with any output from the instrument

e producesaresultslog in order to store, tabulate and subsequently print output from

the instrument

e enablesexport of the output from the instrument to Excel as atext file

A tutorial on UV/Visible spectrophotometry is included as part of the Grafico software.
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Using the I nstrument

The back-lit liquid crystal display is very easy to navigate around using the function / select
and arrow keys on the hard wearing, spill proof membrane keypad.

Q;g‘chrom Libra S6

Keypad

F1, F2, F3, F4 The function select / entry soft keys on the keypad are situated next to
the corresponding option on the display, and are used to select an
appropriate mode

) av When a parameter within a mode needs selecting or changing (as
indicated by || on the display), the four arrow keys

(¢ » « ¥) areused in conjunction with the function keys to make that
selection or change. Use F4 to implement change, followed by ¢ » to
choose between optionsindicated, and « ¥ to enter alphanumeric
characters (for example in the selection of awavelength or entry of a
method title). Then use F4 to accept the change made.

@ to escape or stop making measurements

O0A/100%T to set reference to 0.000AU or 100%T on areference solution at the
current wavelength in the mode selected, or to do areference scan if in
scan mode

[0S to start making measurements

Display The following symbols will appear in bottom right hand corner and mean
the following:

o Use ¢ » « ¥ to select option

RT Ready to set reference or run sample

Note that the light beam shines from LEFT to RIGHT through the cell chamber; ensure the
cell isinserted in the correct alignment. The optical height is 15mm, and the minimum
volume that can be used is approx. 700ul in a semi-micro cell.
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Absorbance and % Transmission

This makes simple absorbance measurements on samples, measuring the amount of
light that has passed through a sample relative to a blank (this can be air). The

procedureis as follows:

Option on display or action Press Comment

Make a measurement F2

Single/ Multi A / Ratio F1

Single A F1

Abs/%T F1 Alternates between the two

Set A F2,then « ¥ Select wavelength

Accept A F2

Insert reference 0A/100%T Used for subsequent samples until
RT on display changed

Insert sample [0 Vaueis displayed

Repeat as necessary

To exit ()

To make up to 4 absorbance measurements on the same sample:

Option on display or action Press Comment

Make a measurement F2

Single/ Multi A / Ratio F1

Multi A F2

Set\'s F1,then « ¥ Select first wavelength

Select A F1,then « ¥ Select second wavelength

Repeat as necessary

All OK F4

Insert reference 0A/100%T Used for subsequent samples until
RT on display changed

Insert sample @ Absorbance values are displayed
Repeat as necessary

To exit Q
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Absorbance Ratio

This makes simple absorbance ratio measurements on samples, measuring the
amount of light that has passed through a sample relative to a blank (this can be air)

at two wavelengths. The procedureis as follows:

Option on display or action Press Comment

Make a measurement F2

Single/ Multi A / Ratio F1

Ratio F3

Remove this row

Set A1 F2,then « ¥ Select wavelength
Accept A F2

Set A1 F2,then « ¥ Select wavelength
Accept A F2

Insert reference 0A/100%T Used for subsequent samples until
RT on display changed

Insert sample [0S Ratio is displayed
Repeat as necessary

To exit ()

Cell Density

This function should be used 0 make an OD600nm reading on a cell culture rather
than a direct absorbance reading as it compensates for turbidity using an auto-
correction; the absorbance at two wavel engths is measured simultaneously and an
algorithm applied to compensate for scattered light. This enables better comparison
with results obtained from other instruments. The procedureis asfollows:

Option on display or action Press Comment

M ake a measurement F2

Cdll Dendity / Proteins F2

Insert reference O0A/100%T Used for subsequent samples until

RT on display

changed

Insert sample

102

Valueisdisplayed; an auto-
correction factor is applied to the
Absorbance value.

Repeat as necessary

To exit

V)
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Scan

An absorption spectrum can be obtained from your instrument, enabling simple
identification of peak height and position. The procedure is as follows:

Option on display or action Press Comment

Make a measurement F2

Scan F4

Abs/%T F1 Alternates between the two

Insert reference O0A/100%T Used for subsequent samples until

RT on display changed

Insert sample [0S Scan is displayed

Repeat as necessary

To identify peaks:

Move cross hairs «)r Abs and A values appear at top

To zoomin on aregion of

interest:

Zoom F2, then Move box that appears on display to area
) av of interest

Zoomin F1 Examine detall

Zoom out F1 Return to original data

To exit ()
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Factor Concentration

Factor concentration mode is used when a conversion factor is known, and is
required to convert the absorbance measurement for a sample at a specific

wavel ength into a concentration, by a ssmple multiplication of absorbance x factor.

The procedure to define a new method is as follows:

Option on display or action Press Comment

Make a measurement F2

Select amethod F3
- v Select method number

New F1 Name is highlighted

Change Name F4,then « ¥ Enter first character of name
> then « ¥ Enter second character of name
> then ~ ¥ Repeat as necessary

Accept F4 A is highlighted

Change Wavelength F4,then « ¥

Accept F4 Unitsis highlighted

Select Units F4,then « ¥

Accept F4 Cal ishighlighted

Select Calibration option F4, then ¢ ? Select Factor

Enter Factor FAthen+ ¥

C F3 Moves decimal point

Positive or negative? F2 Alternates between the two

Accept F4

Kinetics Leave as no

All OK F1 Accept method protocol

Run method F1

Insert reference 0A/100%T Used for subsequent samples until

RT on display changed

Insert sample @ Concentration is displayed

Repeat as necessary

To delete F3, then F1

To exit Q

Note: It isnot necessary to enter the name, and this can be omitted for a quick

measurement.

Issue 01 - 12/2004
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Standard Curve

The construction of a multi-point calibration curve from standards of known
concentration in order to quantify unknown samplesis afundamental use of a

spectrophotometer; this instrument has the advantage of being able to store this curve

as amethod, using up to 5 standards.

To include a zero concentration standard, include this in the number of standards to
be entered and enter 0.00 for concentration; use a blank when required to enter

standard

The procedure to define a new method is as follows:

Option on display or action Press Comment
Make a measurement F2
Select amethod F3
av Select method number
New F1 Name is highlighted
Change Name F4,then « ¥ Enter first character of name
> then « ¥ Enter second character of name
> then ~ ¥ Repeat as necessary
Accept F4 A ishighlighted
Change Wavelength F4,then « ¥
Accept F4 Unitsis highlighted
Select Units F4,then « ¥
Accept F4, ¥ Cal ishighlighted
Select Calibration option F4, then ¢ ? Select Std
Accept F4 Goes to Calibration Curve page
Set Std F1 1 ishighlighted (maximum is 5)
Change F1,then « ¥ Enter concentration of standard 1
e F3 Moves decimal point
Accept F4 2 ishighlighted
Change F1,then « ¥ Enter concentration of standard 2
F3 Moves decimal point
Repeat as necessary
Incorrect entry? F3, then F1, Clearsentry prior to re-entry
“vY F4
Standards are all OK F4 Accept Concentrations
Insert reference 0A/100%T Used for subsequent samples until

RT on display

changed

Insert Standard 1

&

Absorbance for Std 1 is measured
Std 2 is highlighted

Insert Standard 2

&

Absorbance for Std 2 is measured
Std 3 is highlighted

Repeat as necessary

Incorrect entry?

F3, then F1,

Clears entry prior to re-entry

Libra S6, English
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-~ F4

All OK FA Accept Standards

Change Curve Fit agorithm F3,then ¥, F4 Select linear least squaresor
polynomial curve

View Graph F4

Accept graph F3 Can now run samples

To run samples

All OK F1

Run F1

Insert reference 0A/100%T Used for subsequent samples until

RT on display changed

Insert sample @ Concentration is displayed

Repeat as necessary

To delete F3, then F1

To exit ()

To delete F2, then F1

To exit ()
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Kinetics

Kinetics studies, where the change in absorbance needs to be followed as a function
of time at a fixed wavelength, can be readily performed.

Reagent test kits are routinely used for the enzymatic determination of compoundsin
food, beverage and clinical laboratories by measuring NAD / NADH conversion at
340 nm. The change in absorbance over a specified time period can be used to
provide useful information when an appropriate factor, defined in the reagent kit
protocol, is applied. Reaction rate and enzyme activity can be calculated if the factor
used takes account of the absorbance difference per unit time, as opposed to the

absorbance difference per se.

For this reason, the change in absorbance per minute (AA/min), concentration
(AA/min x factor) and correlation coefficient (calculated from abest fit of the data
points) are displayed. They may not be relevant for simple kinetics experiments.

The procedure to define a new method is as follows:

Option on display or action Press Comment
Make a measurement F2
Select amethod F3
av Select method number
New F1 Name is highlighted
Change Name F4,then « ¥ Enter first character of name
> then ~ ~ Enter second character of name
> then « ¥ Repeat as necessary
Accept F4 Waveength is highlighted
Change Wavelength F4,then « ¥
Accept F4 Unitsis highlighted
Enter Units F4, then « ¥
Accept F4 Cal ishighlighted
Select Calibration option F4,then ¢ » Select Factor
Enter Factor F4then « ¥ If required; thisis used to convert
AA/min to Concentration
C F3 Moves decimal point
Positive or negative? F2 Alternates between the two
Accept F4
Kinetics F4,then ¢ » Select Yes or Fixed time*
Accept F4 Start is highlighted
Enter Start Time F4, then Usually 00m 00s, unlessthereisalag
) av time
Accept F4 Interval is highlighted
Enter time interval between F4, then Minimum interval is 10 seconds
each measurement ) av

10
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Accept F4 End is highlighted
Enter end time F4, then Maximum time is 59m 59s after
()av completion of start time

Maximum number of readingsis 20,
so maximum end time is 20 x the
time interval

Accept F4

Run method F1

Insert reference 0A/100%T Used for subsequent samples until

RT on display changed

Insert sample @ Abs values displayed for each time
interval
At end of run, calculated AA/min,
correlation coefficient and
concentration are displayed

To view data

Use Page Up and Page Dn F2 or F3

To view graph F1

() Return to values
Repeat as necessary
To exit Q

* The Fixed time option is for a single time measurement after a specified time, and

therefore no options for start time, time interval and graphics are available.

e |f theinstrument is connected to a chart recorder the output is linearly fitted
between data points as the software automatically interpol ates these for the

benefit of presentation.

e |f you have afactory fitted electrical heated cell holder version of the
Instrument, go to Set-up to switch thisfacility on (37°C). Allow 10 minutes for

the instrument to come to thermal equilibrium.

To recall a saved method

Option on display or action Press Comment
Make a measurement F2
Select a method F3
av Select method number
Accept F4 Selected method is recalled
Run method F1
Insert reference 0A/100%T Used for subsequent samples until
RT on display changed
Insert sample (O3

Issue 01 - 12/2004
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SET UP

Option on display or action | Press Comment

Set up instrument F3

Set Language F1

Select display language “v English, French, German,
Spanish, Italian

Accept F1

To exit Q

Commg/Softwar e Update F2, F1 Select Communications

Select serial printer or PC F1 Alternates between them, with

default settings for each option:
Printer 1 is S1000P

Printer 2 isMartell / Setko DPU-414
PC isfor download to spreadsheet

Set Baud of 9600 or 38400 F2 Alternates between the two

Auto-print F3 Select on for automatic increment
of sample number and print out
after measurement

Accept F4

To exit Q

Set Date/ Time F3

Select format F1 European or North American

Enter values )av Enter as appropriate

Accept F4

To exit ()

Heater control* F4 May not be available*

Heated cell <« Select on for thermostatting at
37°C

Accept F4

To exit Q

*Heated cell holder factory fitted version only. This option cannot be fitted
retrospectively to an instrument.
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ACCESSORIES

PC serial cable (spare) 80-3001-00
S1000P serial printer (includes seria printer cable) 80-3002-53
Chart recorder interface cable 80-3003-55
Test tube adapters (10, 12, 16mm) 80-2117-47

ERROR MESSAGES

After switch on, the instrument undergoes self-diagnostic tests for the tungsten lamp,
wavelength calibration and diode array as part of its calibration procedure (v* for
OK, X for fail). Theresults of thistest are displayed and can be printed out or
output to PC for filing and GLP (Good Laboratory Practice) purpose. The messages
for tungsten lamp and / wavelength calibration are self explanatory, involving
checking that the cell compartment is clear or replacement of the tungsten lamp. In
the unlikely event of a diode array fail message contact your local supplier.

OUTPUT OF RESULTS

Usewith serial printer

The instrument is designed to print to a 40 column seria printer at 9600 Baud.
Output is automatic when a measurement is made. Note that all results can be output
to PC using the serial lead and Grafico software supplied on the user manuals CD.

Use with chart recorder

Kinetics results can be output to a chart recorder using the appropriate cable (80-
3003-55). Voltage setting is 1V per 1 Absorbance unit (£ 10 %) with an offset of
1V = 0.000 Abs on the chart recorder; corresponding %T values are 1V per 100%T
(£ 10 %) with OV = 0%T.

To make the chart cable yourself, you require afemale 9 way D type at one end with
two (1 red, 1 black) 4mm banana plugs at the other (depending on the chart recorder)
and 2 metres of coaxial cable or screened twin core, with the shield connecting the
black plug and pin 5 and the core connecting the red plug and pin 1.

Issue 01 - 12/2004 Libra S6, English 13



USE WITH PC AND THE GRAFICO PC UTILITY
SOFTWARE

Y our instrument is supplied with a serial lead and Grafico software (on the user
manuals CD) that enablesit to be connected to a PC so that results can be captured,
stored, printed and transferred into other applications easily. In particular, a
complete wavel ength scan can be visualised on the PC and copied/pasted into aword
document or powerpoint presentation. An informative tutorial on aspects of
UV/Visible Spectrophotometry is available as part of the software.

| nstallation

The software takes up approximately 0.5Mb of hard disk space when installed.
Proceed as follows to install the software:
1. Place CD into the CD drive of the PC

2. Use Windows explorer to locate the setup.exe file Grafico folder within the
appropriately named instrument folder on the user manuals CD

3. Double click on this so that the software installs, filling out the information as
requested.

4, The software can be started directly by Start > Programs > Grafico.

I ntroduction

e When Grafico is selected, you are prompted to enter the file details (note that
thetitle entered here is used as the title of the wavelength scan graph). After
pressing OK, the instrument (it should be already switched on and connected to
the PC with the serial lead) is recognised by the software.

e There are two parts to the Grafico software, data-logging and scan.

e Thedefault mode is data-logging; this receives instrument output from
absorbance, %T, concentration and rate measurements (including time and date
stamp).

o Results can be copied from Grafico and pasted directly into Excel
for ease of datatransfer. Alternatively results can be saved and
opened up using Excel.

e |f scan modeis selected (View > Scan mode), the full 330-800nm wavelength
scan output from the instrument is shown (just press the run key as usual).
Multiple peaks can be identified using a trace routine and labelled if required
(by dragging the icon at the left side of the displayed graph and releasing at the
appropriate point).

o Graphs can be copied and pasted into Word, Excel or powerpoint

o Graphs can be saved in aformat that can be opened directly by
Excel
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Menu Descriptions

File
New

Save/ Save As

Setup

Print
Print Setup
Exit

Edit
Copy

Clear
Select All

View
Scan mode

File details
Autoscale

Set scae
Display grid
Toolbar
Status bar

Help
Tutorid
Help topics
About

Clears any existing data and starts a new report. Promptsfor file
details (user name, organisation, title, descriptive text)

Savesthe datafilein thefile format selected. Thefile detailsare
included with this data

Displays a tabbed dialogue box so that automatic post process
options for saving of graph, printing of graph and the graph scaling
parameters can be defined. The default data directory can be
defined and is used for all save operations.

Prints the entire file, including a header if defined in File>New
Runs the Common Print Dialog function to set up the printer
Closes the application

Copiesthe datato clipboard for pasting into another application; in
data-logging and scan modes thisistext and graphic, respectively
Clearsthe data from the data set

Selects data and header together

Switches between scan and data logging modes. Successive scans
overwrite existing scans on the display and can be saved if the
autosave functionison

Shows the file details entered at the start (or after File > New) and
allows modification of these details, if required

Automatically sets the scale of the absorbance axis to optimise
presentation (2.5, 2.0, 1.5, 1.0, 0.5, 0.2 or 0.1A)

Sets the scale to user preference (Full, Auto, Define)

Toggles on/off the grid on the graph (for presentation purposes)
View menu bar asicons

View status bar at bottom of display

View tutorial on UV/Visble spectrophotometry
View help topics
View version number etc

Issue 01 - 12/2004
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Practical Aspects

Data logging mode

e When exporting rate mode results you can add the time in 10 second intervalsto
the spreadsheet manually (note that first data point is after 10 seconds, not zero
seconds) and then graph the absorbance / time data (see scan mode — export to
excel for more details).

Scan mode

e Filescan be saved as*.txt, *.csv (opens directly in Excel when double clicked)
or *.wmf (picture) formats

e Label apeak by dragging and releasing the icon at the left side of the graph.
The absorbance/wavel ength details are shown in the title bar. Dragging it again
moves the label; moving it the left hand side takes the label away. Multiple
peaks can be added.

e Usedisplay grid off for clearer presentation.

e Datacan be output in absorbance only

Scan mode — export to Excel and graphing
e If saving asa*.txt file, save the results to folder of choice.
o UseExcd to open thisfile; with files of type set to “al files’
o Notethat saving asa*.csv file and double clicking on it will open
Excel directly
Highlight the wavelength and absorbance values and click the graph icon
Select chart type “ XY Scatter” and the curved lines (no data points) option
L abel the axes etc as required
Double click on the x-axis, select Scale and minimum to 330 and maximum to
800
e  Set colour scheme to suit your preferences
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MAINTENANCE
After Sales Support

Support agreements that help you to fulfil the demands of regulatory guidelines
concerning GLP/GMP are available.

e  Cadlibration, certification using filters traceable to international standards
*  Certificated engineers and calibrated test equipment
e  Approved to 1SO 9001 standard

Choice of agreement apart from break down coverage can include
. Preventative maintenance
*  Caertification

When using calibration standard filters, insert such that the flat surface is facing
away from the spring end of the cell holder

Observe all necessary precautions if dealing with hazardous samples or solvents.

Lamp Replacement

A replacement lamp is available from your supplier using the following part
numbers:

Tungsten Lamp, S1000L 80-2115-33

(use only this tungsten lamp asit is supplied with the connection wires; others will

not operate correctly in this spectrophotometer)

*  Thedesign of the lamp areais such that users are able to change their own
lamps. No lamp alignment is necessary asthe lamp is pre-aligned.

*  Thelamp becomeshot inuse. Ensureit iscool before changing it.

d Do not touch the optical surfaces of the lamp with your fingers (use tissue); if

touched, the area should be cleaned with iso-propanol.
° Instructions for lamp change are provided with the lamp and overleaf.

Issue 01 - 12/2004 Libra S6, English
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To change the lamp, proceed as follows:

1. Switch off the instrument, remove the sample from the cell holder and
disconnect the power supply cord

Remove the protective layers at the lamp access and plug in points on the
underneath of the instrument

Remove the lamp wires from the groove by gently unclipping it

Remove the lamp by twisting the lamp assembly anti-clockwise

Remove the lamp connection end by gently pulling with your fingers
Replace with new lamp using the reverse of these actions

N

oUW

Cleaning and general care of the instrument

External cleaning

Switch off the instrument and disconnect the power cord.

Use a soft damp cloth.

Clean all external surfaces.

A mild liquid detergent may be used to remove stubborn marks.

Changing cell holder or removal for cleaning

e Undo the screws that are visible on the top of the cell holder using a small flat
headed screwdriver and lift the holder out by holding onto the projection; this may
require pushing to the right as you do so in order to prevent fouling against the left
side of the instrument cover.

¢ |nsert the test tube holder and secure in place using the same screws.

¢ Note that aswell removal for cleaning, spillages in the cell holder can be flushed
through using water from a squeeze bottle in order to prevent crystallisation /
fermentation of residues.

Changing the brightness of the display
To change display brightness, proceed as follows:

1. Ensuretheinstrument ison and that there is no sample in the cell holder

2. Remove the protective layer at the lamp plug in point (underneath and at the rear
of instrument)

3. Placetheinstrument on its back, insert a small flat headed screwdriver into the
potentiometer slot and turn it right or left until a suitable level of brightnessis
obtained.
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SPECIFICATION AND WARRANTY

Wavelength range 330 - 800 nm

Monochromator Flat grating

Wavelength calibration Automatic upon switch on

Soectral bandwidth 7nm

Wavelength accuracy + 2nm

Wavel ength reproducibility + 1nm

Light sources Pulsed Tungsten halogen

Detector Diode array

Photometric range - 0.300 to 2.500A, 0.3 to 199%T

Photometric linearity + 2.0 % or £ 0.010A to 1.000A at 546nm, whichever is
the greater

Photometric reproducibility < 0.002 A at OA and 500nm

Stray Light < 1%T 340nm according to ANSI/ASTM E387-72

Sability + 0.005A/h at OA and 546nm after warm-up

Noise + 0.002A near OA and £+ 0.020A near 2A at 600nm

Analogue output 1V per 1 Abs (+10%), 1V = OA offset
1V per 100%T (£10%), OV = 0%T offset

Digital output 9 pin seria

Dimensions 180 x 270 x 390 mm

Weight 1.75kg

Power input 90-265 V, 50/60 Hz, 15 VA

Safety standard EN61010-1

EMC emissions EN 61326-2.3 Generic emissions

EMC immunity EN 61000-4-6 Generic immunity part 1

Mains harmonics EN 61000-3-2

Susceptibility standard IEC 801

Quality System Designed and manufactured in accordance with an 1SO
9001 approved quality system

British Design Registration No. 2097049

Specifications are measured after the instrument has warmed up at a constant ambient
temperature and are typical of a production unit. Aspart of our policy of continuous
development, we reserve the right to alter specifications without notice.

Warranty

Y our supplier guarantees that the product supplied has been thoroughly tested to ensure that it
meets its published specification. The warranty included in the conditions of supply isvalid
for 12 months only if the product has been used according to the instructions supplied. They
can accept no liability for loss or damage, however caused, arising from the faulty or incorrect
use of this product.

This product has been designed and manufactured by Biochrom Ltd, 22 Cambridge Science
Park, Milton Road, Cambridge CB4 OFJ, UK.
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